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Figure 1, Data Acquisition Display Front Panel 
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1. INTRODUCTION 
 
1.0. General 
 
The American Mine Research DAD(Data Acquisition Display) unit is an enhancement to the 
MC-4000 Mine Wide Monitoring System. The unit serves two functions: 
 
1.0.1. Listen Function—It may be placed anywhere in the mine to provide underground  
 personnel access to the same mine monitoring system information made available to the  
 Master Station operator. The unit is connected to the mine monitoring system  
 communications data line and “listens” to the information exchange between the  
 monitoring system Master Station and the monitoring system sensors and/or remotes. 
 This information is interpreted by the unit and displayed on an LCD touch screen  
 display.  
 
1.0.2. Poll Function—It may be used by monitoring system maintenance personnel as a  
 troubleshooting device to isolate communication line  problems to a particular part of the 
 mine. The user isolates the problem area communication line and connects the DAD 
 unit to the to the “inby” sensors and remotes. The DAD unit “polls” the inby devices to 
 establish proper operation of that particular section of the monitoring system.  
 
The DAD unit may be powered by 115 VAC or it may receive power directly from the mine 
monitoring system communication +28 VDC line.  
 
The mine monitoring system configuration is downloaded from the Master Station computer 
to the DAD unit using a serial port.  
 
1.1. Features 
 
The features of the DAD unit are summarized below: 
• 115 VAC or 28 VDC powered. 
• Rechargeable 1.3 amp hour battery. 
• Monitoring System configuration downloaded by serial port. 
• LCD touch screen display. 
• Used underground to troubleshoot Mine Monitoring System. 
• Used underground to provide remote and sensor information to working section  
 personnel. 
• “Sleep” mode when not being used to conserve battery. 
• Displays communication line voltages, AC voltage and DC voltage. 
• Biasing and termination of communication line. 
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2. SPECIFICATIONS 
 

• Enclosure:     Fiber Glass NEMA 3,4,6,12,13 

• Size:       11”W x 13”H x 5.5”D 

• Weight       11 lbs. 

• Power        115 VAC @ 100 Ma. 
         or 15 VDC to 28 VDC @ 50 Ma. 

• Battery      12 Volt, 1.3 Amp Hour, Gel Type 

• Battery Trickle Charge  50 Ma.from Comm Line DC Power 

• Battery Fast Charge  200 Ma.from 115 VAC Power 

• Battery Current    330 Ma. When LCD Display ON 

• DC Powered Wake-up Time 4 Minutes 

• Configuration    Via RS-232 Serial Port 

• Operator Interface   4.75” x 3.5” Touch Screen LCD 

• Comm Line Interface  Fused, transient protected two wire 
         RS-485 

• Communication Baud Rate 38,400 Baud 

• 115 VAC Fuse     1/2 Amp, Fast Blow 

• Comm Line Fuse    1/4 Amp, Fast Blow 
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Figure 2, Data Acquisition Display Block Diagram 
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3. DESCRIPTION 
 
Refer to Figure 1, Data Acquisition Display Block Diagram. 
 
3.0. AC Power Supply and Battery Charger 
The DAD unit may be powered from either 115 VAC or the 15 VDC 
to 28 VDC Communications Line DC voltage. When AC powered, the 
115 VAC power supply provides 24 VDC to a batter charger and 
regulator. The battery charger has both a “fast charge” and 
“trickle charge” capability. When the charging current drops 
below 100 milliamperes, indicating the battery is nearly 
charged, the charger automatically switches to the “trickle 
charge” mode.  
 
3.1. DC Power Supply Battery Charger 
When the DAD unit is powered from the Comm Line DC power, the 
battery charging current is limited to 50 milliamperes. When 
Comm Line powered, the DAD unit monitors the LCD touch screen 
for operator activity. During this time, power to operate the 
LCD display and other circuitry is being provided primarily by 
the battery. If no LCD display buttons are pressed over and 
interval of 4 minutes, the DAD unit enters a “sleep” mode and 
turns OFF the LCD display and the battery is “trickle charged” 
again.   
 
3.2. Battery Disconnect Switch 
A solid-state Battery Disconnect Switch connects the battery 
to the DAD unit LCD display and other circuitry if 115 VAC or 
Comm Line DC voltage is applied to the unit.  
 
3.3. Wake-Up Switch 
A solid-state Wake-Up Switch connects 12 VDC to the LCD dis-
play and to the 5 VDC regulator when the Wake-Up switch 
(mounted on the enclosure) is pressed. A Keep-Awake pulse, 
generated by the DAD unit microprocessor, is applied to the 
Wake-Up switch as long as there is LCD display operator  
activity.  
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3. DESCRIPTION(cont.) 
 
 
3.4. Analog to Digital Converter 
An Analog to Digital Converter accepts voltage inputs from the 
AC power supply, DC Comm Line, Battery and Comm Data Line. The 
converter delivers the digital equivalent of the analog  
voltage inputs to the LCD Touch Screen display. These voltages 
may be view by the operator on the LCD display using the VU 
COMM LINE display menu. 
 
3.5. LCD Touch Screen Display 
The LCD Touch Screen Display receives Comm Line data through a 
RS-485 serial port. In the “Listen” mode application, this 
data contains the Master Station requests for information from 
sensors and remotes and it contains Master Station control 
commands to sensors and remotes. The data also contains the 
replies from sensors and remotes. The DAD unit monitors the 
data exchange between Master Station, sensor and remotes and 
displays this information on the LCD touch screen. Prior to 
using the DAD unit, the Mine Monitoring System Configuration 
is downloaded from the Master Station computer to the DAD unit 
via the RS-232 Serial Port at J10. 
  
 
 
  



Page 11 

 
4. OPERATION 
 
4.1. Configuration 
Before the DAD unit may be used, the mine monitoring system configuration must be 
download to the DAD unit. This allows the DAD unit to properly associate each sensor or 
remote address with the Master Station configuration data. This is accomplished in the  
following manner: 
1) Run the DAD CONFIG program provided by AMR on  the Master Station computer. 
2) Open the File tab and the click on the Create button. 
3) Using a serial cable, connect the Master Station computer serial port to the DAD LCD 

Touch Screen Display J10 connector.  
4) Apply either 115 VAC or Comm Line 28 VDC to the DAD unit 
5) Press the Wake-Up switch on the side of the DAD unit and observe that the LCD display 

illuminates. 
6) On the DAD Entry Menu Screen press the MENU button. 
7) On the DAD Main Menu Screen press the CONFIGURE button.  
8) When in the DAD Configuration Menu Screen press the START CONFIG button. 
9) The menu “Status” area of the screen with change from Wait to Continue. 
10)  At the Master Station computer click on the Download button. The DAD unit  
 Configuration Menu Screen “Packet #” area increment from 1 to 81. When the  
 “Packet #” indicates 81, the “Status” area of the screen will change from Continue to 
 Complete. 
11) The DAD unit now has saved the mine monitoring system configuration data. 
12) Disconnect the serial cable between the Master Station and the DAD unit. The unit is 
 ready to be put in service as a communications “Listening Mode” device or as a  
 troubleshooting “Polling Mode” device. 
 
4.2 Listening Mode 
Connect power (115 VAC or Comm DC ) and the communications data line to the DAD 
unit as described the Installation Section of this manual. Press the Wake-Up switch on the 
side of the enclosure until the LCD display illuminates. 
 
In the “Listening Mode”, the DAD unit monitors the Master Station message sent to each 
sensor and remote and interprets the response from each sensor and remote. The DAD unit 
identifies the address and type (type of sensor and type of remote) and from the configura-
tion data file, displays the response on the LCD Touch Screen display. The sensor and  
remote responses are accessed through a series of screens. 
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4. OPERATION(cont.) 
 
4.2.1. DAD Entry Screen 
The screen shown below appears on applying power to the DAD unit. It displays the “real 
time clock” settings and is the menu used to access the Main Menu. Press the MENU button 
and observe the Main Menu. 
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4. OPERATION(cont.) 
 
4.2.2. DAD Main Menu Screen 
The Main Menu Screen is used to: 
 1) Access the “Listen Mode” menu screens to View Sensor and Remote data; 
 2) Access the “Poll Mode” menu screens to Poll Sensors and Remote; 
 3) Access the Set Clock menu screen to set the real time clock if necessary; 
 4) Access the Set Contrast menu screen to set LCD Display Contrast if necessary; 
 5) Access the Support screen to get the AMR support phone number; 
 6) Access the View Alarms screen to check sensors that have reached the Warn or  
 Alarm level; 
 7) Access the View Comm Line screen to check voltage levels on the communications 
 line; 
 8) Access the Configure screen to download Master Station configuration data. 
 
To access any of the above screens, press the desired menu screen button until the display  
begins to rewrite. 
 
To return to the Entry Menu screen, press the Exit button until the display begins to rewrite. 

Data Acquisition Display 
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SET CLOCK 

SET CONTRAST 

SUPPORT  
EXIT  

POLL REMOTE 
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VU ALARMS 

VU COM LINE 
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4. OPERATION(cont.) 
 
4.2.3. DAD Support Screen 
The Support Screen provides the user with AMR’s technical support number. 
 
To return to the Main Menu screen, press the Exit button until the display begins to rewrite. 

SUPPORT  

      AMR Inc. 
      TECHNICAL SUPPORT 
   1-800-541-5583 
 
 www.americanmineresearch.com 

EXIT  
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4. OPERATION(cont.) 
 
4.2.4. DAD Set Clock Screen 
When the Set Clock screen is initially written the current date and time are displayed. The 
time is not updated so the displayed time should be compared to the real time. If the date 
and/or time is incorrect use the following steps to set the date and/or time. 
1) To set the date, press the Yr, Mon or Day + or—button and observe that the displayed 

date changes appropriately. When the correct date is displayed, press the Set button. 
2) To set the time, press the Hr, Min or Sec + or—button and observe that the displayed 

date changes appropriately. When the correct time is displayed, press the Set button. 
 
To return to the Main Menu screen, press the Exit button until the display begins to rewrite. 

 2003 Aug. 04 

 Exit    Set  
 -Sec 
 +Sec 

 -Min 
 +Min 

 -Hr 
 +Hr 

11  :  24 :  45 

 -Day 
 +Day 

 -Mon 
 +Mon 

 -Yr 
 +Yr 
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 Exit    Rev  

Reset  

 
4. OPERATION(cont.) 
 
4.2.5. DAD Set Contrast Screen 
Use the Set Contrast Menu screen to optimize the LCD display contrast for the existing light-
ing conditions.  
1) Pressing the darker buttons will cause the display to darken.  
2) Pressing the lighter buttons will cause the display to lighten.  
3) The Rev button will cause the display background to reverse between blue and white. 
4) The Reset button will cause the display to return to the preset values.  
 
To return to the Main Menu screen, press the Exit button until the display begins to rewrite. 



Page 17 

 
4. OPERATION(cont.) 
 
4.2.6. DAD Configuration Screen 
Before the DAD unit may be used, the mine monitoring system configuration must be 
download to the DAD unit. This allows the DAD unit to properly associate each sensor or 
remote address with the Master Station configuration data. This is accomplished in the  
following manner: 
1) Run the DAD CONFIG program provided by AMR on  the Master Station computer. 
2) Open the File tab and the click on the Create button. 
3) Depending on computer and/or type of cable (see Page 18).  Connect the Master Station 

computer serial port to the DAD LCD Touch Screen Display J10 connector.  
4) When in the DAD Configuration Menu Screen press the START CONFIG button. 
5) The menu “Status” area of the screen with change from Wait to Continue. 
6)  At the Master Station computer click on the Download button. The DAD unit  
 Configuration Menu Screen “Packet #” area will increment from 1 to 81. When the  
 “Packet #” indicates 81, the “Status” area of the screen will change from Continue to 
 Complete. 
7) The DAD unit now has saved the mine monitoring system configuration data. 
8) Disconnect the serial cable between the Master Station and the DAD unit. The unit is 
 ready to be put in service as a communications “Listening Mode” device or as a  
 troubleshooting “Polling Mode” device. 
 
To return to the Main Menu screen, press the Exit button until the display begins to rewrite. 
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4. OPERATION(cont.) 
 
4.2.6.a Choosing configuration cable and Setup. 
*  If the computer has a COM2 port, use a Serial to Serial cable (AMR Part # 195-0227).   
Return to page 17, step 3. 
 
*  If the computer has a only a COM1 port, use a Serial to Serial cable  
(AMR Part # 195-0227).   Follow the steps on this page. 
 
*  If the computer does not have COM2 port but has a USB port, use USB to Serial cable 
(AMR Part # 195-0228).  Use setup process on page 19. 
 
Step 1.  Open DADConfig.exe and click File>Create and then close DADConfig.exe  
 
Step 2.  Close WinMac and restore Com1 to the original Windows driver only if using XP, 2000, or Millen-
nium, by clicking Start, and right click on My Computer and left click on properties.  Click on the Hardware 
tab and then click on the Device Manager button.  Click on the plus sign next to Ports (COM & LPT). Then 
right click Com1 and Left click  
Update Driver…>Advanced>Next>Don’t Search>Communication Port>Next>Finish. 
  
Step 3.  Click Start>Run… – type regedit and click Ok.  In Registry Editor click the “+” beside of:   
HKEY_USERS> .DEFAULT>Software>DadConfig>Settings                     
Then on the right side of the Registry Editor window double click on “CommPort” and change the “Value 
data” to the Com port 1 (COM1), click Ok and close Registry Editor. 
 
Step 4.  Turn on DAD-P unit, press Menu>Configure>Start Config 
  
Step 5.  Open DADConfig.exe again, click File>Create>Tools>Download.  After the software download 81 
packets, it will be complete and if no error, disconnect cables, close DADConfig.exe, and you are ready to use 
the DAD-P unit! 
 
Step 6.  If the Windows com port driver had to be changed, then the driver must be reinstalled for WinMac to 
work properly by going to Start, and right click on My Computer and left click on properties.  Click on the 
Hardware tab and then click on the Device Manager.  Click on the plus sign next to Ports (COM & LPT). Then 
right click Com1 and Left click  
Update Driver…>Advanced>Next>Don’t Search>Communication Port(ACPI>Next>Finish. 
 
 
 
To return to page 17, step 7. 
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4. OPERATION(cont.) 
 
4.2.6.a Choosing configuration cable and Setup (cont.). 
*  If the computer has a COM2 port, use a Serial to Serial cable (AMR Part # 195-0227).   
Return to page 17, step 3. 
 
*  If the computer has a only a COM1 port, use a Serial to Serial cable  
(AMR Part # 195-0227).   Use setup process on page 18. 
 
*  If the computer does not have COM2 port but has a USB port, use USB to Serial cable 
(AMR Part # 195-0228).  Follow the steps on this page. 
 
Step 1.  Open DADConfig.exe and click File>Create and then close DADConfig.exe  
 
Step 2.  Install USB to Serial cable software: 

Step 3.  In order to check the installation and the COM port number for the USB to Serial cable, go to Start, 
and right click on My Computer and left click on properties.  Click on the Hardware tab and then click on the 
Device Manager.  Click on the plus sign next to Ports (COM & LPT).  Under this heading you should see Serial 
on USB Port (COMxx) where xx is the port number.  This would be the number that you would choose in the 
DAD Configuration software. 
  
Step 4.  Note the COMxx port number and Click Start>Run… – type regedit and click Ok.  In Registry Editor  
click the “+” beside of: HKEY_USERS> .DEFAULT>Software>DadConfig>Settings 
Then on the right side of the window double click on “CommPort” and change the “Value data” to the Com 
port number note from step 3, click Ok and close Registry Editor. 
 
 
To return to page 17, step 3. 
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4. OPERATION(cont.) 
 
4.2.7. DAD View Comm Line Screen 
The DAD View Comm Line screen displays the following voltages to allow the user to 
evaluate the DAD unit power supply and the communications line conditions: 
1) Comm Line DC Volts—Displays the DC voltage provided by the communications 

line.This voltage should be between 15 VDC and 28 VDC. 
2) AC Input DC Volts—Displays the DC voltage provided by the power supply. It is an  
 indication of proper AC input voltage and should be between 20 VDC and 24 VDC. 
3) Battery Volts—Displays the voltage provided by the battery. It is an indication of the 

 battery charge level and should be between 12 VDC and 13.5 VDC. 
4) + Comm Line Bias—Displays the bias voltage on the + Comm Data Line. It should be 

between 2.0 and 2.6 VDC.  
5) - Comm Line Bias—Displays the bias voltage on the - Comm Data Line. It should be  
 between 1.7 and 2.3 VDC. The difference between the + Comm Data Line bias and the  
 - Comm Data Line bias should be between 0.15 and 0.45 VDC. 
6)  + Comm Line Peak—Displays the Peak voltage level on the + Comm Data Line. It 
 should be 1 to 3 volts greater than the + Comm Line Bias voltage.  
7) - Comm Line Peak—Displays the Peak voltage level on the - Comm Data Line. It   
 should be 1 to 3 volts greater than the - Comm Line Bias voltage.  
 
To return to the Main Menu screen, press the Exit button until the display begins to rewrite. 

 DAD - View Comm Line  
 COM LINE DC VOLTS ———- 
 AC INPUT DC VOLTS ———- 
 BATTERY VOLTS  ———- 
 + COM LINE BIAS  ———- 
 -  COM LINE BIAS  ———- 
 + COM LINE PEAK   ———-   
 -  COM LINE PEAK  ———- 
 
 

 Exit  

25.3 
23.6 
13.3 
 2.4 
 2.1 
 4.4 
 4.1 
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4. OPERATION(cont.) 
 
4.2.8. DAD View Sensor Alarms Screen 
The DAD unit monitors the reply of each sensor to the Master Station request for data. If the 
reply indicates the sensor value is above the Warning or Alarm level value displayed on the 
Sensor Alarms screen, the DAD unit will save the value in memory and display the follow-
ing on the on the screen; sensor type, sensor address, sensor value, date and time.  
 
The Warn Value and the Alarm Value may be changed for all sensors using the + and—
buttons. 
The CLEAR button may be used to remove displayed alarms. 
Note: The DAD unit must  be powered and not in the “Sleep" mode in order to capture any 
sensor warning or alarm events. 
 
To return to the Main Menu screen, press the Exit button until the display begins to rewrite. 

  DAD - View Sensor Alarms 

4210-CO  001       17.55        08-05-03  11:20:55  
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    DAD - View Sensor  

SENSOR LOCATION              001 YS OK 0.52  PPM 
SENSOR LOCATION              002 YS OK 0.52  PPM 
SENSOR LOCATION              003 YS OK 0.52  PPM 
SENSOR LOCATION              004 YS OK 0.52  PPM 
SENSOR LOCATION              005 YS OK 0.52  PPM 
SENSOR LOCATION              006 YS OK 0.52  PPM 
SENSOR LOCATION              007 YS OK 0.52  PPM 
SENSOR LOCATION              008 YS OK 0.52  PPM 
SENSOR LOCATION              009 YS OK 0.52  PPM 
SENSOR LOCATION              010 YS OK 0.52  PPM 
SENSOR LOCATION              011 YS OK 0.52  PPM 
SENSOR LOCATION              012 YS OK 0.52  PPM 
SENSOR LOCATION              013 YS OK 0.52  PPM 
SENSOR LOCATION              014 YS OK 0.52  PPM 
SENSOR LOCATION              015 YS OK 0.52  PPM 
SENSOR LOCATION              016 YS OK 0.52  PPM 

 EXIT  DETAIL DN 
PAGE 00 

UP DN UP 

CURSOR 

  LOCATION        AD EN CM     VALUE 

 
4. OPERATION(cont.) 
 
4.2.9. DAD View Sensor Screen 
The DAD unit View Sensor menu screen allows the user to quickly view the performance of 
a block or page of 16 sensors beginning with address 1. The sensor location, address, Comm 
Enabled(YS/NO), Comm Status(OK/NO) and sensor value are displayed.  
 
Use the Page Up/Down buttons to view the next or previous page of 16 sensors. 
 
To view more information about a particular sensor, use the Cursor Up/Down buttons to 
move the cursor to the desired sensor address. Press the Detail button until the screen begins 
to rewrite. 
 
See section 4.2.9.1 for a description of the MC-4110 Sensor Detail Screen. 
See section 4.2.9.2 for a description of the MC-4210 Sensor Detail Screen. 
 

cursor 
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4. OPERATION(cont.) 
 
4.2.9.1. DAD View MC-4110 Sensor Detail Screen 
The DAD unit View MC-4110 Sensor Detail screen provides extensive information about 
the sensor. This information is detailed as follows: 
1) Location label—The sensor’s location as defined in the Master Station configuration file. 
2) Type—MC-4110 or MC-4210. 
3) Address—001 through 255. 
4) Poll/Reply—As the screen is first written, the number of times the sensor has been 

Polled counter is reset and then is incremented along with the number of sensor Replies. 
This informs the user of the sensor’s communication reliability.  

5)   Digital Channels—The name and state of the digital channels, as labeled in the Master 
 Station configuration file,  are displayed.  
6)   Control Channels—The name and state of the control channels, as labeled in the Master 
 Station configuration file,  are displayed.  
7)   Analog Channels—The name and value of the analog channels, as labeled in the Master 
 Station configuration file,  are displayed.  
 
To return to the View Sensor Menu screen, press the Exit button until the display begins to 
rewrite. 

    DAD - Sensor Detail 

 EXIT  

     First North Belt Drive 
    TYPE        ADD   POLL   REPLY 
MC-4110-CO      001   00500    00500 

   DIGITAL CHAN 
#    NAME      STAT 
0   SENSOR TEST           OFF 
1   SENSOR CALIB         OFF 
2   DIG CH0 NOT USED           
3   DIG CH1 NOT USED           

 CONTROL CHAN 
#    NAME      STAT 
0   WARN OUTPUT        OFF 
1   ALARM OUTPUT      OFF 
2   CTR CH0 NOT USED              
3   CTR CH1 NOT USED            

       ANALOG CHANNELS 
CHAN        NAME            VALUE   UNIT 
       0         CARBON MONOXIDE           0.12  PPM 
       1         AN CH0 NOT USED         
       2         AN CH1 NOT USED          
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4. OPERATION(cont.) 
 
4.2.9.2. DAD View MC-4210 Sensor Detail Screen 
The DAD unit View MC-4210 Sensor Detail screen provides extensive information about 
the sensor. This information is detailed as follows: 
1) Location label—The sensor’s location as defined in the Master Station configuration file. 
2) Type—MC-4110 or MC-4210. 
3) Address—001 through 255. 
Poll/Reply—As the screen is first written, the number of times the sensor has been Polled 
counter is reset and then is incremented along with the number of sensor Replies. This in-
forms the user of the sensor’s communication reliability.  
5)   Digital Channels—The name and state of the digital channels, as labeled in the Master 
 Station configuration file,  are displayed.  
6)   Control Channels—The name and state of the control channels, as labeled in the Master 
 Station configuration file,  are displayed.  
7)   Analog Channels—The name and state of the analog channels, as labeled in the Master 
 Station configuration file,  are displayed.  
 
To return to the View Sensor Menu screen, press the Exit button until the display begins to 
rewrite. 

    DAD - Sensor Detail 

 EXIT  

     First North Belt Drive 
    TYPE        ADD   POLL   REPLY 
MC-4210-CO      001   00500    00500 

   DIGITAL CHAN 
#    NAME      STAT 
0   SENSOR TEST           OFF 
1   SENSOR CALIB         OFF 
2   Sensor Digital            OFF 
3   Sensor Digital            OFF 

 CONTROL CHAN 
#    NAME      STAT 
0   WARN OUTPUT        OFF 
1   ALARM OUTPUT      OFF 
2   Sensor Control             OFF 
3   Sensor Control             OFF 

       ANALOG CHANNELS 
CHAN        NAME            VALUE   UNIT 
       0         CARBON MONOXIDE           0.12  PPM 
       1         Sensor Analog      0.04  Volts 
       2         Sensor Analog                0.04  Volts  
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4. OPERATION(cont.) 
 
4.2.10. DAD View Remote Screen 
The DAD unit View Remote menu screen allows the user to quickly view the performance 
of a block or page of 10 remotes beginning with address 1. The remote type(BM-4000, 
CB-PRO, MC-4020, MC-4025, MC-4020/RS, MC-4040/s, MC-4020/R, MC-4040),  
remote location, address, Comm Enabled(YS/NO) and Comm Status(OK/NO) are displayed.  
 
Use the Page Up/Down buttons to view the next or previous page of 10 remotes. 
 
To view more information about a particular remote, use the Cursor Up/Down buttons to 
move the cursor to the desired remote address.  
Press the Analog button to view Analog Channel detail information.  
Press the Digital button to view Digital Channel detail information.  
Press the Control button to view Control Channel detail information. 
 
See section 4.2.10.1 through 4.2.10.3 for a description of the BM-4000 Detail Screens. 
See section 4.2.10.4 through 4.2.10.6 for a description of the CB-PRO Detail Screens. 
See section 4.2.10.7 through 4.2.10.9 for a description of the MC-4020 Detail Screens. 
See section 4.2.10.10 through 4.2.10.12 for a description of the MC-4025 Detail Screens. 
See section 4.2.10.13 through 4.2.10.15 for a description of the MC-4020/RS and  
MC-4040/S Detail Screens. 
See section 4.2.10.16 through 4.2.10.17 for a description of the MC-4020/R and MC-4040 
Detail Screens. 
 
To return to the Main Menu screen, press the Exit button until the display begins to rewrite. 

    DAD - View Remote  

BM-4000 REMOTE LOCATION     001 YS OK 
MC-4025 REMOTE LOCATION     002 YS OK 
MC-4020/RS REMOTE LOCATION     003 YS OK 
BM-4000 REMOTE LOCATION     004 YS OK 
BM-4000 REMOTE LOCATION     005 YS OK 
CB-PRO REMOTE LOCATION     006 YS OK 
BM-4000 REMOTE LOCATION     007 YS OK 
MC-4020/R REMOTE LOCATION     008 YS OK 
BM-4000 REMOTE LOCATION     009 YS OK 
BM-4000 REMOTE LOCATION     010 YS OK 

 EXIT  DN 
 PAGE 0 

UP DN UP 
CURSOR 

   TYPE      LOCATION   AD EN CM 

ANALOG 

VIEW  CHANNEL  DETAIL  

DIGTAL CONTRL 

cursor 
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4. OPERATION(cont.) 
 
4.2.10.1. DAD View BM-4000 Remote Analog Detail Screen 
The DAD unit View BM-4000 Remote Analog Detail screen provides information about the 
Belt Master remote and about the Belt Master remote analog channel data. This information 
is detailed as follows: 
1) Location label—The Belt Master’s location as defined in the Master Station  
 configuration file. 
2)   Type—BM-4000 Belt Master.  
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the Belt Master’s communication reliability.  
5) Analog Channels—The name and value of the analog channels, as labeled in the  
 Master Station configuration file,  are displayed.  
 
To return to the View Remote Menu screen, press the Exit button until the display begins to 
rewrite. 

  DAD - Analog Channel Detail 

 EXIT  

     First North Belt Master 
    TYPE        ADD   POLL   REPLY 
BM-4000       001   00500    00500 

   ANALOG CHAN 
#    NAME     VALUE 
0   CO LEVEL  4.77 
1   Motor A Current         245.39 
2   Motor B Current         245.39 
3   Motor C Current         245.39 
4   Water Flow           558.63 
5   Water Pressure            559.02 
6   Hydraulic Pressure      2239.1  
7   Low Battery           27.7               

   ANALOG CHAN 
#    NAME     VALUE 
8    Drive Speed  100 
9    Belt Speed  100 
10  Sequence Speed  100 
11  Dust Speed  100 
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4. OPERATION(cont.) 
 
4.2.10.2. DAD View BM-4000 Remote Digital Detail Screen 
The DAD unit View BM-4000 Remote Digital Detail screen provides information about the 
Belt Master remote and about the Belt Master remote digital channel status. This information 
is detailed as follows: 
1) Location label—The Belt Master’s location as defined in the Master Station  
 configuration file. 
2)   Type—BM-4000 Belt Master.  
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the Belt Master’s communication reliability.  
5) Digital Channels—The name and status of the digital channels, as labeled in the  
 Master Station configuration file,  are displayed.  
 
To return to the View Remote Menu screen, press the Exit button until the display begins to 
rewrite. 

  DAD - Digital Channel Detail 

 EXIT  

     First North Belt Master 
    TYPE        ADD   POLL   REPLY 
BM-4000       001   00500    00500 

   DIGITAL CHAN 
#    NAME       STAT 
0   Coupler Temp  OK 
1   Belt Alignment  OK 
2   Circuit Breaker  Closed 
3   Ckt Brkr Fault  OK 
4   115 VAC Loss  OK 
5   Spill Switch  OK 
6   Deluge   OK  
7   Remote Switch           OK             

   DIGITAL CHAN 
#    NAME       STAT 
8    Dust Enable  Yes 
9    Speed Enable  Yes 
10  Sequence Enable Yes 
11  Slip Enable  Yes 
12  Dust Fault  OK 
13  Speed Fault  OK 
14  Sequence Fault  OK 
15  Slip Fault  OK 

 KEY 
Auto 

BELT 

Run 
STATUS MESSAGE 

Running 
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4. OPERATION(cont.) 
 
4.2.10.3. DAD View BM-4000 Remote Control Detail Screen 
The DAD unit View BM-4000 Remote Control Detail screen provides information about the 
Belt Master remote and about the Belt Master remote control channel status. This  
information is detailed as follows: 
1) Location label—The Belt Master’s location as defined in the Master Station  
 configuration file. 
2)   Type—BM-4000 Belt Master.  
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the Belt Master’s communication reliability.  
5) Control Channels—The name and status of the control channels, as labeled in the  
 Master Station configuration file,  are displayed.  
 
To return to the View Remote Menu screen, press the Exit button until the display begins to 
rewrite. 

  DAD - Control Channel Detail 

 EXIT  

     First North Belt Master 
    TYPE        ADD   POLL   REPLY 
BM-4000       001   00500    00500 

   CONTROL CHAN 
#    NAME       STAT 
0   Belt Control  Run 
1   Remote Control  Off 
2   Remote Control  Off 
3   Remote Control  Off 
4   Remote Control  Off 
5   Remote Control  Off 
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  DAD - Analog Channel Detail 

 EXIT  

     First North Belt Drive 
    TYPE        ADD   POLL   REPLY 
CB-PRO       001   00500    00500 

   ANALOG CHAN 
#    NAME     VALUE 
0   Average Current  250 
1   Peak Current   1580 
2   Average Voltage           990 
3   Gnd Flt Current          1.12 
4   Magnetic Setting         1800 
5   Thermal Setting             300 
6   Gnd Flt Setting          4.0  
7   Overload Time  540               

 
4. OPERATION(cont.) 
 
4.2.10.4. DAD View CB-PRO Remote Analog Detail Screen 
The DAD unit View CB-PRO Remote Analog Detail screen provides information about the 
CB-PRO remote and about the CB-PRO remote analog channel data. This information is  
detailed as follows: 
1) Location label—The CB-PRO’s location as defined in the Master Station  
 configuration file. 
2)   Type—CB-PRO Circuit Breaker.  
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the CB-PRO’s communication reliability.  
5) Analog Channels—The name and value of the analog channels, as labeled in the  
 Master Station configuration file,  are displayed.  
 
To return to the View Remote Menu screen, press the Exit button until the display begins to 
rewrite. 
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  DAD - Digital Channel Detail 

 EXIT  

     First North Belt Drive 
    TYPE        ADD   POLL   REPLY 
CB-PRO       001   00500    00500 

   DIGITAL CHAN 
#    NAME       STAT 
0   Fuse A   OK 
1   Fuse B   OK 
2   Fuse C   OK 
3   Status   Closed 
4   Fault   No 
5   Key   Program 
6   Locked   No 
7   Digital Label           Off             
   FAULT 
MESSAGE NO BREAKER FAULT 

 
4. OPERATION(cont.) 
 
4.2.10.5. DAD View CB-PRO Remote Digital Detail Screen 
The DAD unit View CB-PRO Remote Digital Detail screen provides information about the 
CB-PRO remote and about the CB-PRO remote digital channel status. This information is 
detailed as follows: 
1) Location label—The CB-PRO’s location as defined in the Master Station  
 configuration file. 
2)   Type—CB-PRO Circuit Breaker.  
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the CB-PRO’s communication reliability.  
5) Digital Channels—The name and status of the digital channels, as labeled in the  
 Master Station configuration file,  are displayed.  
 
To return to the View Remote Menu screen, press the Exit button until the display begins to 
rewrite. 
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  DAD - Control Channel Detail 

 EXIT  

     First North Belt Drive 
    TYPE        ADD   POLL   REPLY 
CB-PRO       001   00500    00500 

   CONTROL CHAN 
#    NAME       STAT 
0   E-Stop   Closed 
1   Close Breaker  Released  
2   Reset Fault  Off 
3   Control Label  Off 
4   Control Label  Off 
5   Control Label  Off 

 
4. OPERATION(cont.) 
 
4.2.10.6. DAD View CB-PRO Remote Control Detail Screen 
The DAD unit View CB-PRO Remote Control Detail screen provides information about the 
CB-PRO remote and about the CB-PRO remote control channel status. This  
information is detailed as follows: 
1) Location label—The CB-PRO’s location as defined in the Master Station  
 configuration file. 
2)   Type—CB-PRO Circuit Breaker.  
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 

 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the CB-PRO’s communication reliability. 

5) Control Channels—The name and status of the control channels, as labeled in the  
 Master Station configuration file,  are displayed.  
 
To return to the View Remote Menu screen, press the Exit button until the display begins to 
rewrite. 
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  DAD - Analog Channel Detail 

 EXIT  

     First North Remote 
    TYPE        ADD   POLL   REPLY 
MC-4020       001   00500    00500 

   ANALOG CHAN 
#    NAME     VALUE 
0   Analog Label  xx.xx 
1   Analog Label  xx.xx 
2   Analog Label  xx.xx 
3   Analog Label  xx.xx 
4   Analog Label  xx.xx 
5   Analog Label  xx.xx 
6   Analog Label  xx.xx 
7   Analog Label  xx.xx 

   ANALOG CHAN 
#    NAME     VALUE 
8    Analog Label  xx.xx 
9    Analog Label  xx.xx 
10  Analog Label  xx.xx 
11  Analog Label  xx.xx 
12  Analog Label  xx.xx 
13  Analog Label  xx.xx 
14  Analog Label  xx.xx 
15  Analog Label  xx.xx 

 
4. OPERATION(cont.) 
 
4.2.10.7. DAD View MC-4020 Remote Analog Detail Screen 
The DAD unit View MC-4020 Remote Analog Detail screen provides information about the 
MC-4020 remote and about the MC-4020 remote analog channel data. This information is  
detailed as follows: 
1) Location label—The MC-4020’s location as defined in the Master Station  
 configuration file. 
2)   Type—MC-4020/IO Multi-Channel Remote and MC-4020 Multi-Channel Repeater.   
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the MC-4020’s communication reliability.  
5) Analog Channels—The name and value of the analog channels, as labeled in the  
 Master Station configuration file,  are displayed.  
 
To return to the View Remote Menu screen, press the Exit button until the display begins to 
rewrite. 
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  DAD - Digital Channel Detail 

 EXIT  

     First North Remote 
    TYPE        ADD   POLL   REPLY 
MC-4020       001   00500    00500 

   DIGITAL CHAN 
#    NAME       STAT 
0   Digital Label  Off 
1   Digital Label  Off 
2   Digital Label  Off 
3   Digital Label  Off 
4   Digital Label  Off 
5   Digital Label  Off 
6   Digital Label  Off 
7   Digital Label  Off 

   DIGITAL CHAN 
#    NAME       STAT 
8    Digital Label  Off 
9    Digital Label  Off 
10  Digital Label  Off 
11  Digital Label  Off 
12  Digital Label  Off 
13  Digital Label  Off 
14  Digital Label  Off 
15  Digital Label  Off 

 
4. OPERATION(cont.) 
 
4.2.10.8. DAD View MC-4020 Remote Digital Detail Screen 
The DAD unit View MC-4020 Remote Digital Detail screen provides information about the 
MC-4020 remote and about the MC-4020 remote digital channel status. This information is 
detailed as follows: 
1) Location label—The MC-4020’s location as defined in the Master Station  
 configuration file. 
2)   Type—MC-4020/IO Multi-Channel Remote and MC-4020 Multi-Channel Repeater.   
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the MC-4020’s communication reliability.  
5) Digital Channels—The name and status of the digital channels, as labeled in the  
 Master Station configuration file,  are displayed.  
 
To return to the View Remote Menu screen, press the Exit button until the display begins to 
rewrite. 
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  DAD - Control Channel Detail 

 EXIT  

     First North Remote 
    TYPE        ADD   POLL   REPLY 
MC-4020       001   00500    00500 

   CONTROL CHAN 
#    NAME       STAT 
0   Control Label  Off 
1   Control Label  Off 
2   Control Label  Off 
3   Control Label  Off 
4   Control Label  Off 
5   Control Label  Off 

 
4. OPERATION(cont.) 
 
4.2.10.9. DAD View MC-4020 and MC-4020I/O Remote Control Detail Screen 
The DAD unit View MC-4020 Remote Control Detail screen provides information about the 
MC-4020 remote and about the MC-4020 remote control channel status. This  
information is detailed as follows: 
1) Location label—The MC-4020’s location as defined in the Master Station  
 configuration file. 
2)   Type—MC-4020/IO Multi-Channel Remote and MC-4020 Multi-Channel Repeater.   
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the MC-4020’s communication reliability.  
4) Control Channels—The name and status of the control channels, as labeled in the  
 Master Station configuration file,  are displayed.  
 
To return to the View Remote Menu screen, press the Exit button until the display begins to 
rewrite. 
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  DAD - Analog Channel Detail 

 EXIT  

     First North Belt Drive 
    TYPE        ADD   POLL   REPLY 
MC-4025       001   00500    00500 

   ANALOG CHAN 
#    NAME     VALUE 
0   CO LEVEL  4.77 
1   Motor A Current         245.39 
2   Motor B Current         245.39 
3   Motor C Current         245.39 

 
4. OPERATION(cont.) 
 
4.2.10.10. DAD View MC-4025 Remote Analog Detail Screen 
The DAD unit View MC-4025 Remote Analog Detail screen provides information about the 
MC-4025 remote and about the MC-4025 remote analog channel data. This information is  
detailed as follows: 
1) Location label—The MC-4025’s location as defined in the Master Station  
 configuration file. 
2)   Type—MC-4025 Line Powered Remote.   
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the MC-4025’s communication reliability.  
5) Analog Channels—The name and value of the analog channels, as labeled in the  
 Master Station configuration file,  are displayed.  
 
To return to the View Remote Menu screen, press the Exit button until the display begins to 
rewrite. 
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  DAD - Digital Channel Detail 

 EXIT  

     First North Belt Drive 
    TYPE        ADD   POLL   REPLY 
MC-4025       001   00500    00500 

   DIGITAL CHAN 
#    NAME       STAT 
0   Coupler Temp  OK 
1   Belt Alignment  OK 
2   Circuit Breaker  Closed 
3   Ckt Brkr Fault  OK 
4   115 VAC Loss  OK 
5   Spill Switch  OK 
6   Deluge   OK  
7   Remote Switch           OK             

 
4. OPERATION(cont.) 
 
4.2.10.11. DAD View MC-4025 Remote Digital Detail Screen 
The DAD unit View MC-4025 Remote Digital Detail screen provides information about the 
MC-4025 remote and about the MC-4025 remote digital channel status. This information is 
detailed as follows: 
1) Location label—The MC-4025’s location as defined in the Master Station  
 configuration file. 
2)   Type—MC-4025 Line Powered Remote.   
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the MC-4025’s communication reliability.  
5) Digital Channels—The name and status of the digital channels, as labeled in the  
 Master Station configuration file,  are displayed.  
 
To return to the View Remote Menu screen, press the Exit button until the display begins to 
rewrite. 
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  DAD - Control Channel Detail 

 EXIT  

     First North Belt Drive 
    TYPE        ADD   POLL   REPLY 
MC-4025       001   00500    00500 

   CONTROL CHAN 
#    NAME       STAT 
0   Belt Control  Run 
1   Remote Control  Off 

 
4. OPERATION(cont.) 
 
4.2.10.12. DAD View MC-4025 Remote Control Detail Screen 
The DAD unit View MC-4025 Remote Control Detail screen provides information about the 
MC-4025 remote and about the MC-4025 remote control channel status. This  
information is detailed as follows: 
1) Location label—The MC-4025’s location as defined in the Master Station  
 configuration file. 
2)   Type—MC-4025 Line Powered Remote.   
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the MC-4025’s communication reliability.  
5)  Control Channels—The name and status of the control channels, as labeled in the  
 Master Station configuration file,  are displayed.  
 
To return to the View Remote Menu screen, press the Exit button until the display begins to 
rewrite. 
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  DAD - Analog Channel Detail 

 EXIT  

     First North Smart Repeater 
    TYPE        ADD   POLL   REPLY 
MC-4020/RS       001   00500    00500 

   ANALOG CHAN 
#    NAME     VALUE 
0   Port 1 Bias  0.30 
1   Port 1 Level  2.40 
2   Port 2 Bias  0.30 
3   Port 2 Level  2.40 
4   Port 3 Bias  0.30 
5   Port 3 Level  2.40 
6   Port 1 Errors  0.00  
7   Port 2 Errors  0.00             

   ANALOG CHAN 
#    NAME     VALUE 
8    Port 3 Errors  0.00 
9    Spare 1   0.02 
10  Spare 2   0.02 
11  Spare 3   0.02 
12  Power Supply  19.2 
13  Port 1 Draw  20.6 
14  Port 2 Draw  39.4 
15  Port 3 Draw  15.9 

 
4. OPERATION(cont.) 
 
4.2.10.13. DAD View MC-4020/RS and MC-4040/S Smart Repeater Analog Detail 
Screen 
The DAD unit View MC-4020/RS and MC-4040/S Remote Analog Detail screen provides 
information about the MC-4020 remote and about the MC-4020 remote analog channel data. 
This information is detailed as follows: 
1) Location label—The MC-4020’s location as defined in the Master Station  
 configuration file. 
2) Type—MC-4020/RS AC Line Powered Smart Repeater and MC-4040/S DC Line  
 Powered Smart Repeater.   
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the MC-4020’s communication reliability.  
5) Analog Channels—The name and value of the analog channels, as labeled in the  
 Master Station configuration file,  are displayed.  
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  DAD - Digital Channel Detail 

 EXIT  

     First North Smart Repeater 
    TYPE        ADD   POLL   REPLY 
MC-4020/RS       001   00500    00500 

   DIGITAL CHAN 
#    NAME       STAT 
0   Port 1 Open  No 
1   Port 1 Short  No 
2   Port 2 Open  No 
3   Port 2 Short  No 
4   Port 3 Open  No 
5   Port 3 Short  No 
6   I/O Comm  No 
7   AC Power           On            

   DIGITAL CHAN 
#    NAME       STAT 
8    Baud Rate Switch On 
9    Kill Switch   On 
10  I/O Board Switch Off 
11  Spare Digital   Off 
12  Spare Digital   Off 
13  Spare Digital   Off 
14  Spare Digital   Off 
15  Spare Digital   Off 

 
4. OPERATION(cont.) 
 
4.2.10.14. DAD View MC-4020/RS and MC-4040/S Smart Repeater Digital Detail 
Screen 
The DAD unit View MC-4020/RS and MC-4040/S Remote Digital Detail screen provides 
information about the MC-4020 remote and about the MC-4020 remote digital channel 
status. This information is detailed as follows: 
1) Location label—The MC-4020’s location as defined in the Master Station  
 configuration file. 
2) Type—MC-4020/RS AC Line Powered Smart Repeater and MC-4040/S DC Line  
 Powered Smart Repeater.   
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the MC-4025’s communication reliability.  
5) Digital Channels—The name and status of the digital channels, as labeled in the  
 Master Station configuration file,  are displayed.  
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  DAD - Control Channel Detail 

 EXIT  

     First North Smart Repeater 
    TYPE        ADD   POLL   REPLY 
MC-4020/RS       001   00500    00500 

   CONTROL CHAN 
#    NAME       STAT 
0   Port 1 Enable  Enable 
1   Port 1 Power  On 
2   Port 2 Enable  Enable 
3   Port 2 Power  On 
4   Port 3 Enable  Enable 
5   Remote Kill  On 

 
4. OPERATION(cont.) 
 
4.2.10.15. DAD View MC-4020/RS and MC-4040/S Smart Repeater Control Detail 
Screen 
The DAD unit View MC-4020/RS and MC-4040/S Remote Control Detail screen provides 
information about the MC-4020 remote and about the MC-4020 remote control channel 
status. This information is detailed as follows: 
1) Location label—The MC-4020’s location as defined in the Master Station  
 configuration file. 
2) 2)   Type—MC-4020/RS AC Line Powered Smart Repeater and MC-4040/S DC Line  
 Powered Smart Repeater.   
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the MC-4020’s communication reliability.  
5)  Control Channels—The name and status of the control channels, as labeled in the  
 Master Station configuration file,  are displayed.  
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  DAD - Analog Channel Detail 

 EXIT  

     First North Belt Drive 
    TYPE        ADD   POLL   REPLY 
MC-4020-R       001   00500    00500 

   ANALOG CHAN 
#    NAME     VALUE 
0   CO LEVEL  4.77 
1   Motor A Current         245.39 

 
4. OPERATION(cont.) 
 
4.2.10.16. DAD View MC-4020/R and MC-4040 Smart Repeater Analog Detail Screen 
The DAD unit View MC-4020/R and MC-4040 Remote Analog Detail screen provides 
 information about the MC-4020 remote and about the MC-4020 remote analog channel data. 
This information is detailed as follows: 
1) Location label—The MC-4020’s location as defined in the Master Station  
 configuration file. 
2) Type—MC-4020/RSAC Line Powered Smart Repeater and MC-4040/DC Line  
 Powered Smart Repeater.   
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the MC-4020’s communication reliability.  
5) Analog Channels—The name and value of the analog channels, as labeled in the  
 Master Station configuration file,  are displayed.  
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  DAD - Control Channel Detail 

 EXIT  

     First North Belt Drive 
    TYPE        ADD   POLL   REPLY 
MC-4020-R       001   00500    00500 

   CONTROL CHAN 
#    NAME       STAT 
0   Belt Control  Run 
1   Remote Control  Off 
5   Remote Kill  On 

 
4. OPERATION(cont.) 
 
4.2.10.17. DAD View MC-4020/R and MC-4040 Smart Repeater Control Detail Screen 
The DAD unit View MC-4020/R and MC-4040 Remote Control Detail screen provides 
information about the MC-4020 remote and about the MC-4020 remote control channel 
status. This information is detailed as follows: 
1) Location label—The MC-4020’s location as defined in the Master Station  
 configuration file. 
2) 2)   Type—MC-4020/R AC Line Powered Smart Repeater and MC-4040 DC Line  
 Powered Smart Repeater.   
3) Address—001 through 99. 
4) Poll/Reply—As the screen is first written, the number of times the remote has been 
 Polled counter is reset and then is incremented along with the number of remote Replies. 
 This informs the user of the MC-4020’s communication reliability.  
5)  Control Channels—The name and status of the control channels, as labeled in the  
 Master Station configuration file,  are displayed.  
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4. OPERATION(cont.) 
 
4.2.11. DAD Poll Sensor Screen 
In the “View Sensor” mode, the DAD unit relies on the Master Station to “poll” or request 
information from the sensor or remote. In the “Poll Sensor” mode, the DAD unit “polls” the 
sensors in the same manner as the Master Station would poll the sensors. Using the DAD 
unit and the Poll Sensor Screen as a troubleshooting device, monitoring system maintenance 
personnel can isolate communication line problems to a particular part of the mine. The user  
disconnects the problem area communication Comm + and Comm -lines and connects the 
DAD unit J1 connector Comm + and Comm—to the “inby” sensors and remotes. Power the 
the “inby” devices is still provided by the Comm +28 VDC line. The DAD unit “polls” the 
“inby” devices to establish proper operation of that particular section of the monitoring sys-
tem. 
 
The DAD unit Poll Sensor menu screen allows the user to select the address of sensor/s to be 
polled and then “enable” communications (poll) with those sensors. The user then observes 
the performance of the selected sensors using a block or page of 8 sensors beginning with  
address 1. The sensor location , address, Comm Enabled(YS/NO), Poll or communication 
Status(OK/NO), and sensor value are displayed.  
 
Use the Page Up/Down buttons to view the next or previous page of 8 sensors. 
 
To “Poll” a particular sensor whose address is on the page, us the CURSOR UP/DN buttons 
to move the cursor to the desired address. Press the POLL button to toggle the ENAB area 
from NO to YES. Observe that the Poll area for the selected address also changes from NO 
to YES and the sensor VALUE begins to update. If the POLL area does not indicate YES, 
the sensor is not responding the DAD unit’s request for data. 
 
To “Poll” a sensor address not on the page, move the cursor up/down to a new line and use 
the 0 thru 9 buttons to enter the desired address. After the entered address appears on the 
SENSOR ADDRESS line, Press the ADDRESS button. The desired address will now appear 
on the line adjacent to the cursor position. Press the POLL button to begin communicating 
with the sensor.  
 
To view more information about a particular sensor, use the Cursor Up/Down buttons to 
move the cursor to the desired sensor address. Press the Detail button until the screen begins 
to rewrite. 
 
See section 4.2.9.1 for a description of the MC-4110 Sensor Detail Screen. 
See section 4.2.9.2 for a description of the MC-4210 Sensor Detail Screen. 
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    DAD - Poll Sensor  

SENSOR LOCATION              001 YS OK 0.52  PPM 
SENSOR LOCATION              002 YS OK 0.52  PPM 
SENSOR LOCATION              003 YS OK 0.52  PPM 
SENSOR LOCATION              004 YS OK 0.52  PPM 
SENSOR LOCATION              005 YS OK 0.52  PPM 
SENSOR LOCATION              006 YS OK 0.52  PPM 
SENSOR LOCATION              007 YS OK 0.52  PPM 
SENSOR LOCATION              008 YS OK 0.52  PPM 

EXIT  

 LOCATION        AD EN CM      VALUE 

ADDRESS POLL   CUR 

DN 
 PAG 
   00 

1) PAG UP/DN  3) ENTR ADD 
2) CUR UP/DN  4) TOGL POLL 
SENSOR ADDRESS 12 

DETAIL 

DN 

UP 

UP 

  0 

  5 

  1 

  6 

  2 

  7 

  3 

  8 

  4 

  9 

cursor 

 
4. OPERATION(cont.) 
 
4.2.11. DAD Poll Sensor Screen 
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4. OPERATION(cont.) 
4.2.12. DAD Poll Remote Screen 
 
CAUTION: 
The user must be aware that in polling a remote control commands are sent that may 
perform some undesired control action, such as start/stopping belts.  
 
In the “View Remote” mode, the DAD unit relies on the Master Station to “poll” or request 
information from the sensor or remote. In the “Poll Remote” mode, the DAD unit “polls” the 
remote in the same manner as the Master Station would poll the remote. Using the DAD unit 
and the Poll Remote Screen as a troubleshooting device, monitoring system  
maintenance personnel can isolate communication line problems to a particular part of the 
mine. The user disconnects the problem area communication Comm + and Comm - lines and 
connects the DAD unit J1 connector Comm + and Comm—to the “inby” sensors and  
remotes. Power to the “inby” devices is still provided by the Comm +28 VDC line. The 
DAD unit “polls” the “inby” devices to establish proper operation of that particular section 
of the monitoring system. 
 
The DAD unit Poll Remote menu screen allows the user to select the address of remotes/s to 
be polled and then “enable” communications (poll) with those remotes. The user then  
observes the performance of the selected remotes using a block or page of 5 remotes 
beginning with address 1. The remote type, remote location, address,  
Comm Enabled(YS/NO) and Poll or communication Status(OK/NO) are displayed.  
 
Use the Page Up/Down buttons to view the next or previous page of 5 remotes. 
 
To “Poll” a particular remote whose address is on the page, us the CURSOR UP/DN buttons 
to move the cursor to the desired address. Press the POLL button to toggle the ENAB area 
from NO to YES. Observe that the Poll area for the selected address also changes from NO 
to YES. If the POLL area does not indicate YES, the remote is not responding the DAD 
unit’s request for data. 
 
To “Poll” a remote address not on the page, move the cursor up/down to a new line and use 
the 0 thru 9 buttons to enter the desired address. After the entered address appears on the 
REMOTE ADDRESS line, Press the ADDRESS button. The desired address will now ap-
pear on the line adjacent to the cursor position. Press the POLL button to begin  
communicating with the remote.  
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    DAD - Poll Remote  

EXIT  ADDRESS POLL   CUR 

DN 
 PAG 
   00 

1) PAG UP/DN  3) ENTR ADD 
2) CUR UP/DN  4) TOGL POLL 
REMOTE ADDRESS 0 

CONTRL 

DN 

UP 

UP 

  0 

  5 

  1 

  6 

  2 

  7 

  3 

  8 

  4 

  9 

BM-4000 REMOTE LOCATION     001 YS OK 
MC-4025 REMOTE LOCATION     002 YS OK 
MC-4020/RS REMOTE LOCATION     003 YS OK 
BM-4000 REMOTE LOCATION     004 YS OK 
BM-4000 REMOTE LOCATION     005 YS OK 

TYPE      LOCATION   AD EN CM 

DIGTAL 

ANALOG 

cursor 

 
4. OPERATION(cont.) 
4.2.12. DAD Poll Remote Screen 
 
To view more information about a particular remote, use the Cursor Up/Down buttons to 
move the cursor to the desired remote address.  
Press the Analog button to view Analog Channel detail information.  
Press the Digital button to view Digital Channel detail information.  
Press the Control button to view Control Channel detail information. 
 
See section 4.2.10.1 through 4.2.10.3 for a description of the BM-4000 Detail Screens. 
See section 4.2.10.4 through 4.2.10.6 for a description of the CB-PRO Detail Screens. 
See section 4.2.10.7 through 4.2.10.9 for a description of the MC-4020 Detail Screens. 
See section 4.2.10.10 through 4.2.10.12 for a description of the MC-4025 Detail Screens. 
See section 4.2.10.13 through 4.2.10.15 for a description of the MC-4020/RS and  
MC-4040/S Detail Screens. 
See section 4.2.10.16 through 4.2.10.17 for a description of the MC-4020/R and MC-4040 
Detail Screens. 
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5. INSTALLATION 
 
The DAD unit is pre-assembled and ready for use when installed using Figure 2, Data  
Acquisition Display Connection Diagram. 
 
5.1. Configuration 
 Before the DAD unit may be used, the mine monitoring system configuration must be 
 download to the DAD unit. This allows the DAD unit to properly associate each sensor 
 or remote address with the Master Station configuration data. See section 4.2.6.. 
5.2. 115 VAC Power 
 Whether the DAD unit is used in the “Listen” or “Poll” mode, 115 VAC power should 
 be used if available. This assures the battery will always be charged. Connect 115 VAC  
 Line, Line Return and Frame Ground to the DAD 253-0356A PC Board connector J2. 
5.3. 28 VDC Communications Line Power 
 When 115 VAC is not available, connect the communications line  +28 VDC wire to 
 the DAD 253-0356A PC Board connector J1 pin 1. Connect the communications line  
 GND wire to the DAD 253-0356A PC Board connector J1 pin 2. Be aware that the  
 DC current drain from the communications line is 50 milliamperes. This will re-charge 
 the battery when the DAD unit is in the “Sleep” mode. The unit enters the “Sleep” after 
  4 minutes of LCD Touch Screen Keypad Display inactivity. 
5.4. Communications Data Line 
 Connect the communications line  + Comm wire to the DAD 253-0356A PC Board  
 connector J1 pin 3. Connect the communications line  - Comm wire to the DAD  
 253-0356A PC Board connector J1 pin 4.  
5.5. “Listen” Mode Comm Line Termination 
 Care should be taken to properly terminate the communication data line depending upon 
 how the DAD unit is being used. This is accomplished by placing the DS1 switches in 
 the proper position. In the “Listen” mode, if the DAD unit is at the end of a 
 communications line, place DS1 position 2 to ON and DS1 positions 1, 3 to OFF. 
 Otherwise, when in the “Listen” mode, place all DS1 switch positions to OFF. 
5.6. “Poll” Mode Comm Line Termination and Bias 
 Care should be taken to properly terminate and bias the communication data line  
 when in the “Poll” mode. This is accomplished by placing all the DS1 switches in the 
 ON position.  
5.7. Wake-Up Switch 
 After the DAD unit has been installed, press and hold the Wake-Up switch(located on 
 the side of the unit), until the LCD display is illuminated. 
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6. USING PORTABLE DAD 
 
The DAD hardware has been packaged in a rugged enclosure so that it may be easily taken  
inside the mine to troubleshoot the mine monitoring system. The user may “View” the same 
information displayed on the Mine Monitoring System Master Station by connecting to the 
monitoring system data line. The user may also “Poll” a monitoring system branch line in 
which it is suspected a problem exists. The four pin panel mount connector has a +28 VDC 
and a GND connection. These are NOT to be used for providing 28 VDC power to sensors 
or remotes. These connections are inputs and are to be used to monitor the DC voltage  
provided by monitor system remotes.  
 
6.1. Power ON Switch 
A Power ON switch has been added to the panel to interrupt AC and battery backup power. 
Use AC power when it is available. Otherwise, the unit will operate continuously for four 
hours before having to recharge the battery. To recharge the battery, connect 115 VAC to the 
unit and place the Power switch to ON. 
 
6.2. Connections at Sensors/Remotes to View Sensor or Remote Data 
When it is necessary to connect to the communications data line inside sensors (and some 
remotes) to “View” sensor and/or remote status information, use alligator clips or J-hooks 
(attached to wires) to connect the Comm (+) and Comm (– ) pins of the four pin panel mount 
connector to the sensor/remote terminal block communications data line Comm (+) and 
Comm (– ) wires.  Use alligator clips or J-hooks (attached to wires) to connect the +28 VDC 
and GND of the four pin panel mount connector to the sensor/remote terminal block  
communications data line +DC and GND wires.  
 
6.3. Connections at the Input of a Repeater to Poll Multiple Branches 
The Portable DAD may be used to “Poll” multiple communication line branches by  
connecting the Comm (+) and Comm (– ) pins of the four pin panel mount connector at the 
input side of the repeater. Be sure to remove the mine monitoring communications lines  
before connecting the DAD communication lines. Use the supplied jumper cable to make 
connections to the repeater input. 
 
6.4. Connections at the Output of a Repeater to Poll a Single Branch 
The Portable DAD may be used to “Poll” a single communication line branch by removing 
the desired output port plug from the repeater connector and connecting the Comm (+) and 
Comm (– ) pins of the four pin panel mount connector to the output port plug Comm (+) and 
Comm (– ) pins. Use the supplied jumper cable to make connections to the output port plug. 
 
6.5. Connections at Sensors/Remotes to Poll Sensors or Remotes 
When it is necessary to connect to the communications data line inside sensors (and some 
remotes) to “Poll” sensors and/or remotes, use alligator clips or J-hooks (attached to wires) 
to connect the Comm (+) and Comm (– ) pins of the four pin panel mount connector to the 
sensor/remote terminal block communications data line Comm (+) and Comm (– ) wires.  .  
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7. TROUBLESHOOTING 
 
Use the table below as a aid in determining the cause of  
problems.   
 
    SYMPTOM       POSSIBLE CAUSE    
 
LCD Display will not     1) Lost 115 VAC power at 253-0356A J2.  
illuminate.      2) Blown F1 fuse. 
         3) Lost +28 VDC power at 253-0356A J1. 
         4) Low battery voltage at J3.  
         5) Loose J5 or J11  connector.  
          6) Defective Wake-Up Switch. 
         7) Defective LCD Display. 
         8) Defective 253-0356A PC Board. 
 
       
DAD does not update sensor or 1) Loose Comm Lines at J1. 
remote data.      2) Blown F2 and/or F3 fuse. 
         3) Incorrect DS1 switch positions. 
         4) Configuration not downloaded from  
          monitor system Master Station. 
         5) Loose J5 or J11  connector. 
         6) Communications line not terminated  
          or biased properly 
         7) Defective LCD Display. 
         8) Defective 253-0356A PC Board. 
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8. SPARE PARTS 
 
 Amr Part Number      Description 
  
  253-0356A       DAD PC Board Assembly 
 
  275-0016       12 Volt, 1.3 Amp Hour Battery 
 
  195-0214       34 Conductor Ribbon Cable Assembly 
 
  195-0215       Display Interface Cable Assembly 
 
  310-0103       LCD Touch Screen Display 
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      DAD MENU TREE 
 
1 ENTRY MENU 
2  MAIN MENU 
3   1) POLL SENSOR 
4     1) MC-4110 DETAIL 
5    2) MC-4210 DETAIL 
6   2) POLL REMOTE 
7    1) BM-4000 
8     1) ANALOG DETAIL 
9     2) DIGITAL DETAIL 
10     3) CONTROL DETAIL 
11    2) CB-PRO 
12     1) ANALOG DETAIL 
13     2) DIGITAL DETAIL 
14     3) CONTROL DETAIL 
15    3) MC-4020 
16     1) ANALOG DETAIL 
17     2) DIGITAL DETAIL 
18     3) CONTROL DETAIL 
19    4) MC-4025 
20     1) ANALOG DETAIL 
21     2) DIGITAL DETAIL 
22     3) CONTROL DETAIL 
23    5) MC-4020/RS AND 4040/S 
24     1) ANALOG DETAIL 
25     2) DIGITAL DETAIL 
26     3) CONTROL DETAIL 
27    6) MC-4020/R AND 4040 
28     1) ANALOG DETAIL 
29     2) DIGITAL DETAIL 
30     3) CONTROL DETAIL 
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31   3) SET CLOCK 
32   4) SET CONTRAST 
33   5) SUPPORT 
34   6) VU SENSOR 
35    1) MC-4110 DETAIL 
36    2) MC-4210 DETAIL 
37   7) VU REMOTE 
38    1) BM-4000 
39     1) ANALOG DETAIL 
40     2) DIGITAL DETAIL 
41     3) CONTROL DETAIL 
42    2) CB-PRO 
43     1) ANALOG DETAIL 
44     2) DIGITAL DETAIL 
45     3) CONTROL DETAIL 
46    3) MC-4020 
47     1) ANALOG DETAIL 
48     2) DIGITAL DETAIL 
49     3) CONTROL DETAIL 
50    4) MC-4025 
51     1) ANALOG DETAIL 
52     2) DIGITAL DETAIL 
53     3) CONTROL DETAIL 
54    5) MC-4020/RS AND 4040/S 
55     1) ANALOG DETAIL 
56     2) DIGITAL DETAIL 
57     3) CONTROL DETAIL 
58    6) MC-4020/R AND 4040 
59     1) ANALOG DETAIL 
60     2) DIGITAL DETAIL 
61     3) CONTROL DETAIL 
62   8) VU SENSOR ALARMS 
63   9) VU COM LINE 
64   10) CONFIGURE 


